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rich or gain wealth and makes no guarantee of success. It is not intended to provide any financial, 
compliance, security, privacy, health, tax, insurance or legal advice. Please consult any and all 
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Welcome! The Eazy VB Ultimate Resource Guide is designed for anyone looking to 
enhance their tech skills and scale their virtual business platform. This guide covers the 
basics of scaling and transforming any business from a traditional paper-based office 
business to a digital, paperless and mobile virtual platform. This e-book is a reference 
guide based on the self-paced, step by step online Eazy VB video course. Throughout this 
guide, I will be referring to the course which is the next step in scaling your virtual 
business. 

I will cover the basic software and hardware devices (I have tested and use myself) to 
scale your own virtual platform.

The information in the guide is based on years of research, trial and error and packed full 
of useful tips and work-arounds.

“I created this system originally for myself because of the inefficiencies of wasted time, 
money and materials I personally experienced by being an entrepreneur and business 
owner. By implementing this platform I was able to close my multiple offices, eliminate the 
overhead, work less and make more money from anywhere and have a better lifestyle. I 
know it sounds cliché but it's true. After having so many inquiries as to how I did this, I 
decided to create this guide and online course to share with others who were looking to do 
the same thing. I hope you find the Eazy VB System as beneficial as I and many others 
have. I wish you all the success you deserve with your career”. 
Best regards,
Craig 5
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Module 1 is the cornerstone of the entire system. The goal of this module is to enable you 
with the tech and tools and knowledge to master your tech skills, enhance and scale your 
virtual business. This guide provides an overview of the virtual business blueprint and how 
to build the foundation of your virtual business platform. In this module, I discuss the steps 
to set up the Eazy VB System to completely update your current workspace and provide 
the pathway to future success. 

Throughout the course there are numerous "Tips" to make your learning experience 
easier and the implementation of the system in your business fast and simple. 

The Tips also provide shortcuts and time saving work-arounds. 

Starting with the next chapter, I will be reviewing the various video software tools that I use 
daily and recommend in this guide / course. I do this to show you exactly what the basic 
capabilities are, how they look to the end user and a glimpse of what you will be able to 
expect, create and incorporate into your workplace. 
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4 Steps To Enhance
Your Virtual Business:

1) COURSE OVERVIEW: The basic technology, essential tools and system to enhance 
your virtual business (which I will refer to as your "office" or "workplace" throughout the 
course). No matter what your level of tech literacy, the course is designed to be easily 
implemented and applied to your existing virtual business.

2) SOFTWARE and HARDWARE: The tech stuff. Review and recommendations of the 
software and hardware used in the Eazy VB system.  (Links & estimated costs included).

3) PAPERLESS BUSINESS: The transition from your current office/workplace set up to a 
100% paperless business by learning how to digitize and organize all paper documents, 
forms, files and promotion materials.

4) UPDATES & TRAINING: Updates and training to implement the hardware and learn the 
fundamental software to improve the functionality and productivity of your virtual business. 
The first step to scaling your business for increased market share and profitability.

First, we’ll talk about the technology- the software and 
hardware you’ll need to make this happen. So let’s get started. 8
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In this chapter, I provide an organized list of software and service providers for scaling 
your virtual workplace. This an overview for the entire course with pricing estimates and 
direct links to review / enroll / download. You may not need all the software on the list to 
build your business, but I wanted to show you your options before you get started. Only 
four (of which three of them are free) are needed to enhance your virtual business.
In the online course this list is frequently updated with new options.

SOFTWARE: (‘Ctrl & Click’ to follow any link or allow to view)

Web Browser - Chrome - utilize Sync (auto save of logins/passwords), bookmarks 
(organizing bookmarks) sharing, multiple extension (Use Safari or Edge for 2nd browser)
Est. Cost: Free
Link to Download

OneNote from Microsoft  - software to create, organize, capture, sync & share on all 
devices. Includes OneDrive cloud storage account.
Est. Cost: Free
Link for Product
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https://www.google.com/chrome/?brand=CHBD&gclid=CjwKCAiA7t3yBRADEiwA4GFlI_RSDqUd-0Jrf9lBf-dyDMLQLQYcIuFLkPuqObgn3TEYDoghWF8Z-hoCm4EQAvD_BwE&gclsrc=aw.ds
https://www.onenote.com/download


Adobe Acrobat Pro - PDF Software - with Document Cloud storage
Est. Cost: $15 mo. / $180 yr.
Link for Product

Adobe Scan - Mobile (Tablet / Smartphone) Document / Business Card Scanning 
Software that works with Adobe Acrobat Pro
Est. Cost Free
Download from Apple / Microsoft App Store
Link for Product Info

Computer Backup - Carbonite Pro (HIPAA compliant/encrypted option available)
Est. Cost: Basic service $6 Mon. / $72 yr. | $12 mon. / $149 yr. (HIPAA Compliant)
Link to Service

Second phone line on your cell phone - Sideline
Est. Cost: $99 yr.
Link for Service

Online Appointment Scheduler - Calendy
Est. Cost: $15 mo. / $180 yr.
Link for Service
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https://clk.tradedoubler.com/click?p(264355)a(3146616)g(22804962)url(https://www.adobe.com/creativecloud/plans.html)
https://acrobat.adobe.com/us/en/mobile/scanner-app.html
http://partners.carbonite.com/my-data-protection
https://www.sideline.com/?irgwc=1&source=Impact&impactradius_click_id=RBlxGI1agxyOUNi0RHQK3XRkUknXl2x5w3LFXc0&campaign=Craig%20W%20Colley&adgroup&creative=TEXT_LINK_Link1_2p1n
https://calendly.com/


Online (Screen Share) Meetings - Zoom
Est. Cost: Free (up to 40 min. meetings for multiple attendees).
Link to Service

Video Email - Bombbomb
Est. Cost: $70 mo. / $840 yr.
Link for Service

Email Marketing - GetResponse
Est. Cost: $50mo. / $600yr. (for advanced automation email replies etc.)
Link for Service

Gotfreefax - Faxing Software
Link for Service
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https://zoom.us/
http://www.bombbomb.com/?bbref=COLIDAY
https://www.getresponse.com/?a=JNTyKMGNVG
https://www.gotfreefax.com/


Chat on Website - Drift
Est. Cost: Free (pro package available)
Link for Service

Website Services - Domain names, Email (using drafts for reference links/docs etc.) 
templates, signature) Wordpress Hosting, SSL, Shopping carts
Est. Cost: Email: $6 mo. $72 yr. | Website hosting - $9 mo. / $108yr.
Link for Services

Microsoft 365 - Office Suite of products; Word, Excel, PowerPoint, One Drive, One Note
Est. Cost: $69 - 99 yr.
Link for product

Website Design for WordPress - ThriveThemes
Est. Cost: $19 mo. / $228 yr.
Link for Service
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https://www.drift.com/
https://www.secureserver.net/?prog_id=coliday&ci=1767
https://microsoft-us.evyy.net/ZAnPq
https://thrivethemes.com/affiliates/ref.php?id=9606


Wondershare - Video conversion, screen recording
Est. cost:
Link to Product

Monosnap - Screen capture software
Link for Service

Logitech Webcam & Video Software (Logitech Capture)
Link for Free download

TIP: Because of the number of logins and passwords you will accumulate, I suggest 
creating a password protected file in a program like Word (learn how to protect document 
in lesson to follow) of all logins, passwords, serial numbers, links to software/product 
source/providers.  Also create a password protected PDF copy of the Word doc to share 
on different devices. Keep files in the same folder for easy access and updates. Save new 
versions periodically. Sometimes files can become corrupted. If using Adobe Acrobat Pro, 
store in Document Cloud

In review: We’ve covered the software basics, provided links of where to access, 
download and create accounts and provided estimated costs for budgeting purposes. Now 
we're going to move onto the hardware you're going to need to work in conjunction with 
the software.
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https://videoconverter.wondershare.net/ad/uniconverter-all-in-one-video-converter.html?gclid=Cj0KCQjwx7zzBRCcARIsABPRscPlDzmKMFFl87j3AyxAO8aC8X7CwmysLzkWV_Z2CX2DPQWJoM1h3HsaApfkEALw_wcB&utm_expid=.JOoiVuXbRK6UwkrAcBuQ4A.1&utm_referrer=https%3A%2F%2Fwww.google.com%2F
https://monosnap.com/
https://support.logi.com/hc/en-us/articles/360024699934--Downloads-C922-Pro-Stream-Webcam
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In this chapter I provide a detailed and comprehensive list of hardware and product 
providers used in the Eazy VB system. You do not need all of these to create your virtual 
business. As your business and marketing needs grow you can add what your business 
requires. 

I strive to make starting or scaling your business as affordable as possible. 

Note on mobile devices used in this course: In this course I use an iPhone and an iPad 
Pro in all mobile examples. (Androids, other Smartphones and Surface Pro type tablets 
should work but not tested).

Below are the most cost-effective iPhone / iPad recommendations if you do not already 
have one. You do not need the latest iPhone / iPad as they tend to be expensive and not 
needed for your virtual business to thrive. Some older models work very well with this 
system and are compatible with current software updates from Apple.

TIP: I recommend a cell phone plan with unlimited data. 
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Phone 6 Plus - RECOMMENDED - Affordable with large screen. (like the one used is this 
course). The iPhone 6+ is recommend because of its size (larger screen) and hotspot 
capability (which allows you to use the phone as a mobile WiFi connection when traveling 
or when WiFi is not available). Wired headsets/external microphones can be plugged into 
the unit.
Link to View

iPad Pro - Larger screen with pencil (like the one used is this course) (Microsoft Surface is 
another option but not tested). The iPad Pro 2nd Generation like the iPhone 6 Plus (both 
used in this course) is an older model. Wired headsets/external microphones can be 
plugged into the unit.
Link to View

TIP: Newer iPhone's / iPads have Lightning jacks only and need additional audio adapters 
and can not be charged at the same time. (More in advance audio / video lessons).

iPad Carry Case
Link to View
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https://www.amazon.com/Apple-iPhone-Plus-Fully-Unlocked/dp/B07D1CPRBN/ref=sr_1_3?keywords=iphone%2B6%2Bplus&qid=1584138936&sr=8-3&th=1&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=c50ab8452c7d9157a6d756fb3e171312&camp=1789&creative=9325
https://www.amazon.com/Apple-Wi-Fi-Model-256GB-Refurbished/dp/B078HWZYQP/ref=sr_1_3?crid=3EDU5NH94C6QY&keywords=ipad%2Bpro%2B2nd%2Bgeneration&qid=1584166721&s=electronics&sprefix=ipad%2Bpro%2B2nd%2Celectronics%2C205&sr=1-3&th=1&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=e13d02e300be43df80b9c3452e949243&camp=1789&creative=9325
https://www.amazon.com/gp/product/B0787SL95W/ref=smi_www_rco2_go_smi_3905707922?_encoding=UTF8&ie=UTF8&psc=1&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=125276877a65e836b17a6d8b517b94c3&camp=1789&creative=932


Apple pencil, tip & eraser replacements
Link to View

Screenwriting glove
Link to View

Laptop - recommend larger screen
Link to View

External Hard Drive
Link to View
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https://www.amazon.com/s?k=apple+pencil+tip+%26+eraser&ref=nb_sb_noss&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=ec03b17c61ea40ea0981d8787d04e398&camp=1789&creative=9325
https://www.amazon.com/gp/product/B018VASU3O/ref=ppx_?&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=765faa2d6b56388a375d594749c61e7b&camp=1789&creative=9325
https://www.amazon.com/Acer-Display-i3-10110U-802-11ax-A515-54-37U3/dp/B07XPLHL3K/ref=redir_mobile_desktop?ie=UTF8&aaxitk=UaQ4e39rrYKyHZpQ1B81qg&hsa_cr_id=1562469510201&ref_=sb_s_sparkle&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=1d6f1d5f254fc22ff7bdb79377cd0eda&camp=1789&creative=9325
https://www.amazon.com/dp/B06VVS7S94/ref=twister_B081ZV4WBZ?_encoding=UTF8&psc=1&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=e221faf916ae4e0d7ce3608646dd8542&camp=1789&creative=9325


Scanner - Brother (See Chapter 6 for file labeling prior to scanning).
Link to View

Printer - Brother
Link to View

USB Audio / USB Multi Hub
Link to View

Webcam - Logitech 922
Link to View
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https://www.amazon.com/Brother-Wireless-ADS-1700W-Professionals-ADS1700W/dp/B07FRBFVDN?ie=UTF8&ac_md=6-2-QmV0d2VlbiAkMTkwIGFuZCAkNDAw-ac_d_pm&cv_ct_cx=brother%20scanner&keywords=brother%20scanner&pd_rd_i=B07FRBFVDN&pd_rd_r=49f559a8-37d2-4c19-8976-9085f147e78f&pd_rd_w=YqC1e&pd_rd_wg=UeUUk&psc=1&qid=1582764523&ref_=sxin_2_ac_d_pm&s=electronics&psc=1&qid=1582764523&s=electronics&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=66ba3d2274f352e775d4a6ae35c660a1&camp=1789&creative=9325
https://www.amazon.com/Brother-DS-620-Lightweight-Compatible-BR-Receipts/dp/B00EKWE55K/ref=sr_1_7?keywords=brother+portable+printer&qid=1582764597&s=electronics&sr=1-7ble+printer&qid=1582764597&s=electronics&sr=1-7&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=cad03eeb6ae588fda3d03b4378f06118&camp=1789&creative=9325
https://www.amazon.com/Micolindun-External-Sound-Adapter-Laptop/dp/B06XNJLHXS/ref=pd_rhf_se_p_img_3?_encoding=UTF8&psc=1&refRID=4XVGWNQMCYR9T81QP28N&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=6ba7f525dee3fb38bf1358142cec3999&camp=1789&creative=9325
https://www.amazon.com/gp/product/B01MTTMPKT/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=7aac3c07de756bec69b3365467906e7e&camp=1789&creative=9325


Lavaliere mic (wired)
Link to View

IPhone adapter for iPhones with plugs (adapter will depend on model of iPhone)
Link to View

Headset with mic (USB – Wired)
Link to View

Headset with noise cancellation (covers both ears)
Link to View
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https://www.amazon.com/gp/product/B016C4ZG74/ref=ppx_yo_dt_b_asin_title_o00_s00?ie=UTF8&psc=1%20%20with%20USB%20/&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=bb7c74c17a2bf0967084683eb34cb99c&camp=1789&creative=9325
https://www.amazon.com/gp/product/B017VHXG0A/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=215166b334dd6cbd31d4b1954a8e4aa0&camp=1789&creative=9325
https://www.amazon.com/dp/B016P4GJ3Q/ref=psdc_172541_t2_B00TSXFM1C?&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=a374e0756971cbdafb34e54980ec5ec4&camp=1789&creative=9325
https://www.amazon.com/iMicro-IM320-USB-Headset/dp/B003RRY8ZG/ref=as_li_ss_tl?s=electronics&ie=UTF8&qid=1538151160&sr=1-3&keywords=imicro+sp-im320+usb+headset+with+microphone&dpID=419zdS7bIGL&preST=_SY300_QL70_&dpSrc=srch&linkCode=sl1&tag=nakishawynn0e-20&linkId=0489d9503cdb648494064bbcf3ef95fe&language=en_US&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=0ff08ef72976d9ea4d22b35ffad232b1&camp=1789&creative=9325


Small USB power supply
Link to View

Portable AC / USB / Laptop Charger
Link to View

Small iPhone light
Link to View

Small tripod
Link to View
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https://www.amazon.com/Luxtude-PowerEasy-Portable-Certified-Lightning/dp/B072LX482G/ref=sr_1_1_sspa?crid=2W2OGJPFZMC5I&keywords=usb+portable+charger+for+iphone&qid=1584163372&sprefix=usb+portabale+%2Caps%2C224&sr=8-1-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUEyNkFMUUVUTTZWRkE1JmVuY3J5cHRlZElkPUEwNDA2MjkyMkE2SDFQV1BNNU5aRSZlbmNyeXB0ZWRBZElkPUEwMzQwNzE0MUxQTVBDRTk3WlM0VyZ3aWRnZXROYW1lPXNwX2F0ZiZhY3Rpb249Y2xpY2tSZWRpcmVjdCZkb05vdExvZ0NsaWNrPXRydWU=&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=38c28722bdabaefb4dce05b445f8c291&camp=1789&creative=9325
https://www.amazon.com/Portable-RAVPower-20000mAh-External-Nintendo/dp/B0829V9V7C/ref=sr_1_12_sspa?keywords=ac+portable+laptop+charger&qid=1584163649&sr=8-12-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUFMRDNCSUJSRFE0RFcmZW5jcnlwdGVkSWQ9QTAxMDg2NTgyVE5PMzlRWkNMUlFRJmVuY3J5cHRlZEFkSWQ9QTA2MTI1MjYxSE0zVjBPTlY2SEhFJndpZGdldE5hbWU9c3BfbXRmJmFjdGlvbj1jbGlja1JlZGlyZWN0JmRvTm90TG9nQ2xpY2s9dHJ1ZQ==&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=b2db6928a0bb2f3dc3a0cca857c6c4a6&camp=1789&creative=9325
https://www.amazon.com/Auxiwa-Selfie-Rechargeable-Battery-Camera/dp/B01MCZ2WY8/ref=sr_1_1_sspa?keywords=iphone+light&qid=1582765078&sr=8-1-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUFLQ0FEOUNVNlpXVE4mZW5jcnlwdGVkSWQ9QTAxOTY0MzIyVUk4V1RHRTVKVEg2JmVuY3J5cHRlZEFkSWQ9QTAzMTgwMDkyVlFONEI4VUI5V1cyJndpZGdldE5hbWU9c3BfYXRmJmFjdGlvbj1jbGlja1JlZGlyZWN0JmRvTm90TG9nQ2xpY2s9dHJ1ZQ==&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=6e73fae2b559379afa8f29be0792c4df&camp=1789&creative=9325
https://www.amazon.com/UBeesize-Portable-Adjustable-Universal-Compatible/dp/B06Y2VP3C7/ref=sxin_2_osp48-b39e7e3d_cov?ascsubtag=amzn1.osa.b39e7e3d-e3f9-49e1-9ba1-c0695381fbd7.ATVPDKIKX0DER.en_US&creativeASIN=B06Y2VP3C7&cv_ct_cx=iphone+tripod&cv_ct_id=amzn1.osa.b39e7e3d-e3f9-49e1-9ba1-c0695381fbd7.ATVPDKIKX0DER.en_US&cv_ct_pg=search&cv_ct_wn=osp-search&keywords=iphone+tripod&linkCode=oas&pd_rd_i=B06Y2VP3C7&pd_rd_r=e6eb9fa8-2037-43c4-af49-2bb3ced11251&pd_rd_w=rQcmB&pd_rd_wg=dwOzF&pf_rd_p=dac4d66e-658f-4cae-b10d-a35ac5eca0c3&pf_rd_r=ZC038NQS85P25AX6VMYW&qid=1584164457&tag=spyonsite-20&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=875e072d948d0ae01ed6b872607b4482&camp=1789&creative=9325


Large tripod
Link to View

Selfie stick with light
Link to View

AC three-way extension cord. - Make sure it is 3 prong
Link to View

Lap desk - (computer tray)
Link to View

Briefcase / Padded Over the Shoulder Case
Link to View
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https://www.amazon.com/AmazonBasics-Lightweight-Camera-Mount-Tripod/dp/B00XI87KV8/ref=sr_1_4?keywords=tripod&qid=1584164683&s=electronics&sr=1-4&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=97dcc8cc67e2bf67b923ddec10ed4a0f&camp=1789&creative=9325
https://www.amazon.com/Hpory-Wireless-Bluetooth-Compatible-Extensible/dp/B07PH45V95/ref=sr_1_1_sspa?dchild=1&keywords=selfie+stick+with+light&qid=1588047673&sr=8-1-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUEzS0I4UVhIUFhWQTkwJmVuY3J5cHRlZElkPUEwODI0NTkwOVVOM1cxS1U3T0JCJmVuY3J5cHRlZEFkSWQ9QTAyMzQ1NzhaQThOS1NIOEtWMUQmd2lkZ2V0TmFtZT1zcF9hdGYmYWN0aW9uPWNsaWNrUmVkaXJlY3QmZG9Ob3RMb2dDbGljaz10cnVl
https://www.amazon.com/dp/B01F4EKXTY/ref=sspa_dk_detail_3?psc=1&pd_rd_i=B01F4EKXTY&pd_rd_w=rGk28&pf_rd_p=c83c55b0-5d97-454a-a592-a891098a9709&pd_rd_wg=MpfAw&pf_rd_r=E313FVJZESXN5YP8JPSM&pd_rd_r=8264ce62-b884-4025-9127-81dd972f5646&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUFZQUVDQjlHRExQWUcmZW5jcnlwdGVkSWQ9QTA5MDE5MTUxVUlKQ0VYQTcwTTIwJmVuY3J5cHRlZEFkSWQ9QTA2MjMzMDAzS1JBMVhOMFJGT0JJJndpZGdldE5hbWU9c3BfZGV0YWlsX3RoZW1hdGljJmFjdGlvbj1jbGlja1JlZGlyZWN0JmRvTm90TG9nQ2xpY2s9dHJ1ZQ==&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=ee0f753b6afc34b3b61571aba70ef706&camp=1789&creative=9325
https://www.amazon.com/HOME-BI-Laptop-Built-Cellphone/dp/B07C3C9BNV/ref=sr_1_6?keywords=laptop+lap+tray&qid=1584165518&sr=8-6&_encoding=UTF8&tag=coliday-20&linkCode=ur2&linkId=6e17ef9381fb42c5c08c9ca2cb2d421b&camp=1789&creative=9325
https://www.amazon.com/gp/product/B01KTA7S2S/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1


In Review: We’ve covered the software and hardware basics, provided some links of 
where to access and download (cost estimates on purchase pages) , create accounts and 
make purchases. 

The choice is yours when it comes to creating your virtual workplace. 
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Now we're going to move on to organizing and digitizing your current documents, etc. 
you're going to need in conjunction with the software and hardware.
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In this chapter we will be setting up or re-organizing your workplace. This exercise is 
probably the least enjoyable task you will do in this entire course. It is, however, one of the 
most important steps to take. The success of your business will depend on how well you 
organize your work-space. Realistically, with an active practice you may not have the time 
to do this all at once. To begin, at least create all the categories you will need and start a 
little at a time.
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Three Steps: Download worksheet

1) Declutter and organize documents digitize.

2) Begin by sorting into separate categories. Example: clients, seminar and workshop 
leads, mailing list leads, promo/marketing materials, carrier product brochures, 
certificates/licenses, training, images/pdfs.

3) Discard what you do not need. One of biggest problems in decluttering is thinking you 
need to save everything. You don’t. Clean house!

TIP: Most companies / carriers offer PDFs of their products. No need for company 
brochures/application/forms / (unless requested and can be ordered) otherwise email / text 
all info to clients / prospects. The truth is 99% of what your carry and distribute are 
discarded or put in a drawer, folder or file cabinet and are never looked at again. You need 
to break this cycle of wasted time and materials.

In Review: After completing this task you should have gleaned your files and everything 
you are going to use for your business in separate marked piles ready to be scanned and 
digitally organized. We will address in upcoming lessons how to integrate your current 
folder/file system on your computer into this new system. 

26

SETTING UP YOUR WORKPLACE 2 of 2  

WWW.EAZYVB.COM

https://secureservercdn.net/198.71.233.87/e21.c1a.myftpupload.com/wp-content/uploads/2020/03/Eazy-VB-Course-Worksheet-Set-up-Workplace.pdf


In this chapter we’ll take a deep dive into folder / document preparation and scanning.

At this point you should have your paper files etc. organized and separated into defined 
categories ready to be scanned.

Next, we’ll  use the Eazy VB ‘Digital Filing System’ and create folder  & filing system for 
where and how to save the files.

1) Folder / File layout: Download Worksheet

Folder layout (hard drive on desktop and or laptop)
Main Folder | Category | Individual File Folder | Files

2) File name: Develop a habit of labeling every folder and file with the same naming 
system.

Option 1: Name (First & Last), Category & Date
John_Doe_LI_07052020 (Month, Day & Year)

Option 2: Date, Name (First & Last) & Category  
07052020_John_Doe_LI
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SAMPLE:
My Virtual Business (Hard Drive) | Clients - Prospects (Category) | 
John_Doe_LI_07052020 (Folder) | John_Doe_LI_07052020 generic Info (File)

TIP: Mirror folder / file names in your cloud storage, email and bookmarks.

TIP: Create acronyms for easy labeling and file retrieving 

Example using the insurance business:
Life Insurance - LI
Medicare - MED 
Long Term Care - LTC 
Annuities - AN
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5 Steps to Implement your Digital Filing System:

1) Create an organized folder/file set up on an external or internal hard drive.

TIP: All hard drives should be backed up as mentioned in the software review chapter. Link 
to Service (Carbonite) TIP: Create shortcuts to common files on PC (quick access) or Mac 
(favorites).

2) Scan and label all documents etc. with suggested Digital File System (above) or one of 
your choosing. Either way the system needs to be easy to duplicate and simple to 
search/find data/documents.

3) If you have important notes on paper pads, journals, scrap or post it notes, scan and label 
those as well. 

4) Depending on your scanner, many can scan business cards and automatically extract the 
data into a software program.

5) Organize PDF product brochures, forms, reports, charts, marketing pieces, mailers, flyers 
etc. the same way. Companies and carriers usually provide product materials and forms on 
their website or in your agent/private portal.

In Review: Now you have your folders and files ready to 
implement into your new system 29
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Now we're ready to start building the framework for your workplace. At this point you should 
have the basic hardware (purchased if necessary) set up and ready to use 
(computer/tablet/smartphone).
We are going to begin filling in the pieces of this virtual puzzle by downloading and installing 
the 4 basic software's to your computer/devices.

We’ll start with Chrome by Google. (You can use other browsers, but they will not be 
covered or referenced in this course).

1) First access or create your own Google account. This is required for Chrome and 
necessary for the SYNC function to work.
Access Link

2) Download Chrome. DOWNLOAD LINK by Google and works on a Mac and/or PC. By 
using the sync feature all history, bookmarks, login and passwords can be safely saved and 
shared on any device including your tablet and cell phone. The security and sharing 
capability provides a reliable safe and secure online experience. For a tablet or iPhone, 
download the Google Chrome app from the App Store.

3) Configure Chrome with sync functions, start up tabs, bookmarks, cache and cookies.
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TIP: What are Cookies? Cookies are created when you visit a website. They are used to 
store bits of information about your interactions with the website, which the web server can 
use later when processing your sessions. ... To be technical, your browser is the program 
that mediates cookie control between your computer and the website.

In Review: Congratulations! Most of the heavy lifting is over. Now that Chrome is installed 
as your web browser, we are finally ready to download the basic software and build your 
system.
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OneNote is the foundation of the virtual business system. You maybe already using 
another software which is fine if it provides the same functionality as OneNote.

OneNote can be used to create reports, handwritten printed letters, convenient and 
ongoing handwritten notepads, business lines, vendor, client sections and pages, among 
many other uses. 

I suggest you click the link and download this free software to have a look.

Link to Download OneNote (for computer)
Go to the app store on your tablet or smartphone to download the App.

TIP: Some functions work better on laptop (text, folder arrangement, tables, printing) and 
some functions work better on iPad (writing, drawing and resizing). 

In the Online Course I cover the set up, shortcuts, tips and tricks, troubleshooting, how to 
create and organize notebooks, sections, pages and use search functions.
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OneNote Overview. There 7 keys areas: (Covered in detail in the online course).

1) Menus: Home, Insert, Draw, View & Help: (text, tools, tabs, draw, pen, color, size, 
create new pens, audio, tables, insert PDF, copy/paste text from another document or 
website/URL).

2) Notebook: section, pages (create, copy, move, delete), open / close notebooks

3) Home: Works like a word document. (No drawing capability)

4) Insert: Table, Pictures, Camera, File, PDF

5) Draw: Text; Select placement on page and enter text. (Setting default from home page)  

6) Draw: pen, color, size, create new pens

7) View: (Section, copy / move / delete (create templates) 
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Acrobat Pro is an advanced PDF software. The desktop / laptop (computer) and tablet 
versions vary in their functionality and are covered in separate lessons in the online 
course.

Acrobat Pro has an abundance of features making it the default “go to” program I 
recommend and use in this system.

This software has annual subscription and runs about $15.00 a month.
LINK TO SUBSCRIBE Select Acrobat Pro and install.

In the online course I focus on the most common and useful features for use in your 
business. 

TIP: Personally, I use Adobe's Creative Suite which includes all their products (Photoshop, 
Acrobat, Premier etc.) LINK TO SUBSCRIBE for Creative Suite - select "All Apps"). This 
is for advanced users and isn't necessary for this course or your business when starting 
out.

With an annual subscription or an Adobe Acrobat Pro subscription this product is coupled 
with Document Cloud storage. The stored files are also accessible between your 
computer, tablet and smartphone. All files are accessible on both Mac & PC.
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Your computer will be used primarily when working with most PDFs. Your tablet will be 
used more for sharing, entering handwritten data and presentations.

TIP: I share in the online course several shortcuts and techniques I've developed when 
working with paper forms and signatures using this program. 

Adobe Acrobat Pro, along with OneNote are the two main programs used in this 
system. 
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The free Adobe Scan mobile app works on your mobile device, scans documents into 
PDFs and automatically recognizes text. With Adobe Scan you can easily capture and 
convert documents, forms, business cards, and whiteboards into high-quality Adobe PDFs. 
And with different capture modes, you can ensure that you capture the clearest scan every 
time. This an excellent option to use when traveling or meeting with clients to capture 
necessary information.

TIP: You will need to access the Apple App Store and download the app. You will need an 
apple account (login and password to do so).

Basic scanning:

Open app
1) Select whiteboard, Form, Document or Business Card
2) Icon Options, Add photo, Auto-Capture (On/Off), Flash (Auto On/Off), File Save.
3) Click File Save bottom right corner, crop or retake> Continue
4) Name file (default) “Scan & Date” > click pen to change
5) File saved to Scan folder in Document Cloud
6) Option to Share, Open in Acrobat, Comment, … More

TIP: Business card scans can be added to contact list automatically on iPhone.
LINK TO ADOBE HELP PAGES
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In this chapter I illustrate an overview of how the Eazy VB system works. This chapter lists 
the steps covered in detail in the online course. For the sake of productivity, this is more 
than an exercise. Be sure to use an actual prospect / client so the result is not just a 
simulation. This will serve as a first profile and a template for all future activities / entries in 
your virtual office / workplace.

DOWNLOAD WORKSHEET

1) Gather information

Create a folder on your main hard drive (desktop/laptop) in the appropriate category. In 
this example I will use a life insurance prospect. 

Suggested FOLDER label: 
Example: “Client - Prospects”

You can select any category that works for you. 
The system works the same for every type of prospect / client.

2) Create Client MASTER Folder

This will be the Master Folder for this this client/prospect and will contain all information; 
images, documents, illustrations, pdf’s etc.
Example: “John_Doe_LI_07052020” 40
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3) Open Acrobat
Create Folder in Document Cloud
(example: “Client - Prospects”)
Create Client SUB Folder (Name it the same as what is on the hard drive) 
“John_Doe_LI_07052020”

4) Open OneNote
Create a Notebook> name it “My Virtual Business”
Create a Section> name it “Client - Prospects”
Create a Page> tap the text tool and enter “Name”
Enter descriptive info (with abbreviations / acronyms).

By default, the Draw tab is automatically selected.

Example: “John_Doe _A56_ LI_T_400k_30yr_St_NT”
Sample Acronyms:
A- Age
LI- Life Insurance
T- Term
St- Standard
NT- Non-Tobacco
The date of entry will automatically be entered underneath the name.
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Select View> Rule Lines / Paper Style (iPad)

Default font: (first time only) set to 16 point,
(on computer "..."> options or "gear icon"> edit & view on iPad)

Select Draw tab> enter notes / text

5) Open Contacts on Cell Phone (See Worksheet)

Create Contact
Use same name setup as OneNote
“John Doe  A56  LI T 400k 30yr St NT”
List info under the first name field.

TIP: When you have many prospects and clients it helps identify them when they call/text. 
This makes browsing your customer list easier and eliminates the need to open other 
notes for basic info.

That’s it! Congratulations you’ve created your first contact
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This is an overview of adding Images, PDFs & URL links to OneNote and Adobe 
Document Cloud.
DOWNLOAD WORKSHEET

Regarding Images: 
Images (jpegs, pings, gifs etc.) can be saved as PDFs.

On hard drive, right click image(s) and
"Convert to Adobe PDF" or "Combine Files in Acrobat" for multiple images into one pdf. 
Save to hard drive, document cloud or both.

TIP: Images will not be able to be added to Document Cloud unless they are converted to 
PDFs.

Images From Desktop / Laptop

1) Open page in OneNote
2) Click Insert tab
3) Select the Picture Icon
4) Select From File
5) Locate on hard drive, double click or open
6) You can click cut, copy, paste, delete, reposition and resize.
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PDF From Desktop / Laptop

Open page in OneNote
Click Insert tab
Select the Printout Icon
Select PDF from hard drive
Click to resize / reposition
Delete small Adobe icon

From iPad
If a page was created and edited previously on your desktop/laptop it will be ready to open 
on your iPad/tablet without the need of the following steps and vice versa.

Load PDFs to Document Cloud
Since an iPad does not have direct access to external hard drive, one solution is to 
converting images to a pdf. 

1) In Acrobat: Open PDF from hard drive
2) "Save As" to appropriate Category folder in Document Cloud
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On iPad> Open OneNote
1) Select page
2) Select Insert tab
3) Choose location on page (where you want to insert PDF)
4) Press and release
5) Select the Picture / PDF Icon
6) Window pop up box opens
7) Select folder and file
8) Click to resize / reposition. Files are commonly placed at the bottom of your page. You 
can click cut, copy, paste, delete or hold ("x" in middle of the page)  and move to reposition 
and resize if needed.
9) Delete small Adobe icon

TIP: Once images / PDFs are inserted into a page, OneNote makes a copy that is 
embedded into the page.

Links and Content from Website Page & URL Address

1) Select content from web page (drag and copy)
2) Select Text icon in Draw tab
3) Select location (click and release) Info with copy into page

TIP: The URL (website site address) will be 
automatically added at bottom of copy on desktop only. 45
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RECAP OF MODULE 1
OVERVIEW
You have completed the overview 
of Module One.

The Tech & Tools provided in this 
guide and online course system 
will enable you to begin using  your 
virtual business in your daily 
practice.

The Modules to follow (available in 
the online course) will help you add 
additional software / hardware and 
advanced marketing techniques to 
your business.

The Online course videos explain 
in detail, with a series of lessons to 
help you advance your tech skills 
and quickly set up and continue to 
scale your virtual business.

IN REVIEW WE HAVE COVERED:

1) Organizing Workspace

2) Software and Hardware
3) Decluttering / Scanning

4) OneNote

5) Acrobat
6) Adobe Scan

7) Creating a prospect / client profile

8) Adding images, PDFs & URL links
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BONUS > Free Access
Watch 2 Eazy VB Course Lessons
Click below to watch actual video lessons and LEARN MORE from the online course.
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	3) Open Acrobat�Create Folder in Document Cloud�(example: “Client - Prospects”)�Create Client SUB Folder (Name it the same as what is on the hard drive) “John_Doe_LI_07052020”��4) Open OneNote�Create a Notebook> name it “My Virtual Business”�Create a Section> name it “Client - Prospects”�Create a Page> tap the text tool and enter “Name”�Enter descriptive info (with abbreviations / acronyms).��By default, the Draw tab is automatically selected.��Example: “John_Doe _A56_ LI_T_400k_30yr_St_NT”�Sample Acronyms:�A- Age�LI- Life Insurance�T- Term�St- Standard�NT- Non-Tobacco�The date of entry will automatically be entered underneath the name.��
	Select View> Rule Lines / Paper Style (iPad)��Default font: (first time only) set to 16 point,�(on computer "..."> options or "gear icon"> edit & view on iPad)��Select Draw tab> enter notes / text��5) Open Contacts on Cell Phone (See Worksheet)��Create Contact�Use same name setup as OneNote�“John Doe  A56  LI T 400k 30yr St NT”� List info under the first name field.��TIP: When you have many prospects and clients it helps identify them when they call/text. This makes browsing your customer list easier and eliminates the need to open other notes for basic info.��That’s it! Congratulations you’ve created your first contact�
	This is an overview of adding Images, PDFs & URL links to OneNote and Adobe Document Cloud.�DOWNLOAD WORKSHEET��Regarding Images: �Images (jpegs, pings, gifs etc.) can be saved as PDFs.��On hard drive, right click image(s) and�"Convert to Adobe PDF" or "Combine Files in Acrobat" for multiple images into one pdf. Save to hard drive, document cloud or both.��TIP: Images will not be able to be added to Document Cloud unless they are converted to PDFs.��Images From Desktop / Laptop��1) Open page in OneNote�2) Click Insert tab�3) Select the Picture Icon�4) Select From File�5) Locate on hard drive, double click or open�6) You can click cut, copy, paste, delete, reposition and resize.�
	PDF From Desktop / Laptop��Open page in OneNote�Click Insert tab�Select the Printout Icon�Select PDF from hard drive�Click to resize / reposition�Delete small Adobe icon��From iPad�If a page was created and edited previously on your desktop/laptop it will be ready to open on your iPad/tablet without the need of the following steps and vice versa.��Load PDFs to Document Cloud�Since an iPad does not have direct access to external hard drive, one solution is to converting images to a pdf. ��1) In Acrobat: Open PDF from hard drive�2) "Save As" to appropriate Category folder in Document Cloud�
	On iPad> Open OneNote�1) Select page�2) Select Insert tab�3) Choose location on page (where you want to insert PDF)�4) Press and release�5) Select the Picture / PDF Icon�6) Window pop up box opens�7) Select folder and file�8) Click to resize / reposition. Files are commonly placed at the bottom of your page. You can click cut, copy, paste, delete or hold ("x" in middle of the page)  and move to reposition and resize if needed.�9) Delete small Adobe icon��TIP: Once images / PDFs are inserted into a page, OneNote makes a copy that is embedded into the page.��Links and Content from Website Page & URL Address��1) Select content from web page (drag and copy)�2) Select Text icon in Draw tab�3) Select location (click and release) Info with copy into page��TIP: The URL (website site address) will be �automatically added at bottom of copy on desktop only.�
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